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 Warning!
It is  essential that you read and understand this  entire manual, the entire Yaskawa F7 User Guide and 
the entire contents  of the savvy software “Help” menu before proceeding with your installation and 
product configuration. For more information and to download product manuals  and software, go to 
www.driveweb.com.

 Warning!
Your use of savvy software, drive.web devices  and drives may cause motors  and machinery to power 
up with high voltages  or start or operate in an unexpected, dangerous or lethal way. It is  essential that 
you are completely familiar with savvy and all of the equipment and the system design you are 
working with before attempting to program or edit a program or connect to any live device.

 Warning!
You are entirely responsible for the configuration or use of any drive.web product. By configuring or 
using these products you agree to indemnify and hold harmless  Bardac Corporation, its’ employees, 
directors, officers, distributors  and resellers  against the consequences  of your configuration or use of the 
products.

dw115 smarty-yf7  Introduction
Take control of your Yaskawa F7, expand your interface and add 
computation power with this  rugged, versatile, and easy to use, process 
and drives  management system.  Create large integrated systems where 
processing bandwidths are not affected by system size.

smarty-yf7 Features
drive.web Distributed Process Control over Ethernet
Modbus TCP/IP over Ethernet with option 04.
Internet accessible configuration, monitoring & control. 
“Drag ‘n drop,” easy connections with graphical documentation.

Automated, on-line upgrades with savvy software.
System libraries Basic, Process Control, Winders, Math & Encoder.
Function Blocks; Extensive drive parameter control and monitoring.  

Arithmetic, logic, PID, comparator, filter, latch, timer, counter, 
ramps, winder diameter, taper tension, torque compensator, more.

I/O options; Universal In, Analog Out, Digital I/O, Two Encoders, and Ethernet. 
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smarty-yf7 Available Options
smarty-yf7 models  include drive.web over Ethernet, Distributed Process 

Control, comprehensive Yaskawa F7 interface via 19.2 kbps, EIA485 
serial connection, Basic Control Function Block Library with arithmetic, 
logic, PI, clamps, data switches  and more.  Please see Appendix A for a 
complete listing of  function blocks by library and option. 

03 I/O Package - UIP’s (7), AOP’s (2), DIO’s(3), 10V Ref. 10mA max.

Seven Universal Inputs multi-range analog, digital, differential

Two Analog Outputs 0 to 10V, 10mA max. 10 bit resolution

Three configurable Digital Inputs or Outputs. 24V, 50mA output.

04 ModbusTCP/IP.  Ethernet, 10baseT enabled Modbus slave/server. 

05 Process Control. Function Block Library 1 - Math, Logic, PID, 
Switches, Comparators, User data log, Profiler, Presets, Latch, Filters, 
Counters, Timers and more, see Appendix A.

06 Winder Control Function Block Library 2 - Diameter Calculator, 
Taper Tension, Torque Compensator.

07 and 08 Encoder 1 and 2 Inputs. Bi-directional with marker, EIA 
422/485, 24V, 300kHz  With encoder logic, position, speed functions.

09 Real time clock-battery backup, calendar, and event time-stamp.

10 Advanced Math Function Block Library 3 - Trig, Polynomials, Log, 
Exponent, more, see Appendix A.

11 Encoder Control Function Block Library 4 - Speed Lock, 
Registration, Position (Requires Option 07 and 08)

smarty-yf7 Options Important Notes:
Options 04, 05, 06, 10 and 11 are software options, easily field installed.

Option 08 includes an isolated serial port with green and yellow LEDs  that 
indicate EIA485 data being received and transmitted.

Your use of smarty option 04 may cause motors  and machinery to power 
up with high Voltages  or start or operate in an unexpected, dangerous  or 
lethal way. IT is  essential that you are completely familiar with the 
ModbusTCP/IP protocol and all of the the equipment and the system 
design you are working with  before attempting to use this option.

smarty-yf7 Winder Specials 
Include options  05 and 06, pre-installed generic winder  
system configuration and a wiring diagram drawing for 
fast commissioning of  a wide range of  winder applications.

1101 smarty winder 1  Open Loop Constant Tension Center Winder. 

1102 smarty winder 2 Closed Loop Dancer Control Center Winder. 

1103 smarty winder 3 Closed Loop Loadcell Control Center Winder.
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smarty-yf7 Physical Installation
Mount on DIN rail in an electrical enclosure that provides  the required 
environmental protection. You can mount with zero clearance on the side of the 
drive but provide at least 5” space if  mounting directly above or below the drive.

smarty yf7 Dimensions and Weight: 2.3”w, 4.5”h, 4.7”d (59, 115, 120mm)  1.0 lb (0.45 Kg)
smarty yf7 Power Requirements: Regulated 24VDC ±15%, 50mA plus loads. 

smarty is fitted with a 1A auto reset fuse

smarty yf7 Storage and Operation Environment: Temperature range; 0 to 50C. 
Humidity less than 95% non-condensing.

smarty yf7 Ethernet Port Standard RJ45 8P8C, 10BaseT, Link and Activity LED’s

Set up Your Yaskawa F7, WARNING!
You must read and understand the entire Yaskawa F7 User Manual before proceeding! Dangerous, 
high voltages will exist that may cause injury or death! Only qualified personnel should proceed!

Check parameter U1-14, Flash ID = 3020. This is currently the only supported software.
You will need to connect the terminals, S- and R-, together for EIA485- or A.  S+ and R+ 
connected together make the EIA485+ or B connection. Connect 1G directly to C.
Set the baud rate at parameter H5-02 to 4 for 19.2 kbps.
Check the Modbus Unit address, Parity and Delay times are at default settings:  

H5-01 = 1F = Address, decimal 31
H5-03 = 00  No Parity
H5-06 = 05  Minimum delay, 5ms 

Based on your application, set H5-04, Stopping Method and H5-05, Serial Fault 
Detect to determine how the drive will respond to a serial connection loss.
Important Note:  You must cycle the YF7’s  power, waiting for the screen to blank 
before repowering, in order for the changes to take effect.

smarty-yf7 Ethernet Networking & Programming
It is important to have a basic understanding of Ethernet TCP/IP networks. 
Assigning an invalid or duplicate IP address will cause serious network malfunctions! 
speedy485s  are all shipped with the IP address, 10.189.189.189. Consult your 
company’s IT department for an appropriate, unique IP address.

Find useful networking information in the Basic Network Administration in 
the savvy user manual under the Help menu. 

Set up Your Physical Ethernet Network - You Will Need:
A standard Category 5e cable (with 8P8C/RJ-45 connectors  on both 
ends) for each drive.web  device and your computer.
An Ethernet switch with sufficient ports  to support all your drive.web 
devices and your computer.

Set up Your Computer - Get savvy
With free drive.web savvy software, easily program and monitor your smarty-
yf7, perform data trending and create distributed control systems.

Download the latest version of savvy and view the savvy user manual. Go to 
driveweb.com, click on Get savvy or get savvy on the Bardac Infodisk.

Windows users  will need to have Java Runtime Environment installed to 
run savvy. There is a link on the  Get savvy page to download Java for free.  
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Get started with savvy
Before proceeding with your systems designs it is  very important to familiarize 
yourself  with savvy, the configuration software. 
We strongly recommend that you read the introductory guides  under the Help 
menu; Getting Started with savvy, Getting Started with savvy-SFD, and 
savvy-SFD and the PL series drive.
Use Create Phantom in the Directory menu to practice, explore all drive.web 
products and options and design and configure off-line. Design systems in 
Phantom devices  and Export Data under the Directory menu for later use in 
live devices. Import Data into  phantoms to work off-line. 
We strongly recommend you attend our free on-line training seminars. Call us  or 
email training@driveweb.com to register.

Under the Directory menu, click on Discover All Local Devices. If your 
smarty-yf7 is  powered up and physically connected to the same local 
network as your computer, an icon should appear on the screen.  
If the icon at right appears  with the red padlock and comms-fail indication, a 
network connection problem exists. Check connections, LEDs  and that the 
smarty  IP address is within your computer’s subnet mask.  
Warning! Changing a device IP address WILL disrupt its network 
connections! If a smarty is  communicating with other devices or drives  you 
must be prepared for system disruption and to remap connections  in those 
devices  when changing an IP address. In the File menu choose Utility > Remap 
Export File to remap a dw-system file with different IP address(es).

Under the File menu click Set IP Addresses for System. Identify your 
smarty’s serial number and enter an IP address  within your computer’s  subnet 
mask. A YF7 icon should appear. 
The icon with question mark indicates  no communication has been made. The clear 
icon indicates  a good serial connection.  The double arrow and yellow triangle 
instantly warns you if  serial communication with the drive is interrupted.  
If a red warning triangle is  superimposed on the icon, your computer has lost 
Ethernet communication with your smarty. Check your Ethernet 
connections and that your smarty still has 24VDC power. 
Right click on the icon and choose Change Name  to name your smarty.   
Click the YF7 icon to view the first level, device overview screen. You can access 
the drive control and monitoring parameters, the Function Block Engine and if 
you have option 04, a Modbus icon.  Left click to view the next level. 
Click on function blocks to view and adjust parameters. 
Click on parameters  to open the setter box unless  they show a crossed-out 
pen meaning that they are read-only.  You can adjust the parameter value 
with mouse or keys.
Right-click on parameters  to get info, add to a dock, copy, start or end 
connections, rename, and rescale.
drive.web works  with 16 bit words allowing raw decimal integer values  0 to 
65535 or ±32767. These raw values  are limited and/or scaled depending 
on the parameter.  This prevents  illegal values and  presents  numbers  in the 
most useful formats.  Right-click to adjust scaling to fit your needs. Check 
scaling when making connections. 
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Upgrade savvy with Signal Flow Diagram Option - SFD
With savvy-SFD, build systems  graphically while creating 
live drawings that are stored in your speedy485.  
Set borders, drag and drop connections, zoom, pan, cross-
reference and annotate multi-page drawings. 
A separate function block and connection listing shows 
program execution order from top down. Change execution 
order by dragging function blocks up or down. 
Select Upgrade savvy under the Commerce menu. 
Process  a Voucher or credit card on-line any time. Contact 
us  with the savvy ID shown in the About drive.web savvy 
window for an off-line upgrade Coupon.

smarty-yf7 Terminals 

smarty-yf7 Option 03 AOP, DIO & UIP
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Drawing Number Issue

Designed By

Date

Title

Drum Winder App

Your smarty
Page

1
of

1

UIP1 Analog Line Speed Input

D1

Line Speed Input

Output Scaler

Watchdog@5071

Output Offset

User Logger@5067

device log

tag

data

store

Comparator@5058

Comparator@5100

Drum Speed Demand AOP1

100% = 10V

0% = 0V

C2

IN / OUT

Material Thickness

SR Latch@5089

S

R

Q

Integrator@5112

dt

Linear Ramp@5051

Drum Speed Demand

Square Root@5110

x

2-In Switch@5047

Actual Diameter of Material

5065) Lay Diameter

0.00 %

another smarty

Holding Register UINT16@4863.4867) Last Error

another smarty

DIO1 Encoder Select.5109) Output

another smarty

DIO1 Encoder Select.5109) Output

another smarty

DIO1 Encoder Select.5109) Output

Terminal Block A
Encoder 2 Input (Option 08)

Serial port with option 08 is isolated. 
Includes LEDs, green, data received, 

and yellow, data sent.  

Terminal Block D 
Universal Input/Outputs, 0V Ref.

24VDC power supply input

10base T Ethernet port, RJ45
with LEDs. Green, link & yellow, activity 
for easy programming and networking.

Terminal block C
10V Ref., Analog Out & Digital Input/Outputs

Terminal Block B
Encoder 1 Input (Option 07)

A  B  C

+24V 0V

A 1  2  3  4  5  6  7  8 A

B 1  2  3  4  5  6  7  8 B

C 1  2  3  4  5  6  7  8 C

D 1  2  3  4  5  6  7  8 D

+24V 0V

C 1  2  3  4  5  6  7  8 C

D 1  2  3  4  5  6  7  8 D

Terminal Function 
D1 	 UIP1 
D2 	 UIP2 
D3 	 UIP3 
D4 	 UIP4 
D5 	 UIP5 
D6 	 UIP6 
D7 	 UIP7 
D8 	 0V

Terminal Function 
C1 	 +10V Ref.
C2 	 AOUT1 
C3 	 AOUT2 
C4 	 0V
C5 	 DIO1 
C6 	 DIO2 
C7 	 DIO3 
C8 	 0V



Terminal Block C ~ 10V, Analog Outputs and Digital I/O
C1, 10V Reference. Supplies 10mA max current.
C2, C3, Two Analog Outputs. 0V to 10V, 10mA source,10 bit res. 

Input parameter 0% to 100% translates to 0V to 10V output.
C5, C6, C7, Three Digital I/O Terminals. Click on the, 

“Output Enable,” parameter to change from input to output or 
connect to dynamically configure.  Connect, 0 = Input and 1 = 
Output.

Output Configuration; 24V with 50mA max. source current 
is  output to the terminal when the function block’s  input parameter 
is set to High or ≥ 1  
Input Configuration: Input parameter is  ignored and output 

parameter follows  24V logic at the terminal. High = 1 and Low = 
0. Threshold is  ~8V with 4V hysteresis.  12V logic may NOT 
function properly.

Terminal Block D ~ Universal Analog/Logic Inputs
D1 - D7, Seven UIP’s 100KΩ input impedance, 12-bit resolution.

Monitor a terminal as  an analog, logic, or differential input in 
separate function blocks.
Dynamically configure logic and analog ranges  by connecting to 
the Range parameter.
Set the Differential Block Range to the maximum expected 
voltage difference between the two input terminals. The output is 
the percentage difference between the terminals over this range.

Option 04 ModbusTCP/IP Server
Conformance Class 0, Function Codes 03 &16. 
Up to three simultaneous masters.
View the Modbus Slave function block by clicking on the Modbus 
icon in your savvy system configuration.
ModbusTCP Slave Port 502 is  the standard specified in the 

protocol. You can change to match the Modbus master in the 
unusual case that it is non-standard.

Modbus Slave Indirect parameters  are sequentially numbered so all or groups  can be 
read or written with one command.  Enter any parameter number in your function 
block engine in these parameters. Create more Modbus Slave Indirect blocks  from 
the Utility function block list group.
You are not required to use the Modbus Slave Indirect blocks. Your ModbusRTU 
master can directly address any numbered parameter in your function block engine.
Right-click on parameters  and Get Info. You cannot write or force parameters that 
cannot have incoming drive.web connections  nor parameters  with incoming 
drive.web connections indicated by a blue arrow at left side of  the parameter block. 
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UIP Analog Block
Range	 Analog Range
  0 
 ± 100 mV
  1 
 ± 5 V
  2 
 ± 10 V
  3 
 ± 100 V
  4 
 ± 200 V

UIP Differential
Range	 Input Ranges
  0 	 100 mV
  1 	 5 V
  2 	 10 V

smarty + option 03
AOP1@5118

100% = 10V

0% = 0V

C25118) Input

0.00 %

5119) Monitor

0.00 V

smarty + option 03
DIO1@5115

! 8V

hysteresis ! 4V

C5

5115) Input

High

5116) Output Enable

Output

5117) Output

High

smarty + option 03
UIP1 Logic@5107

D1

5107) Monitor

0.0 V

5108) Range

24V Logic

5109) Output

Low

smarty + option 03
UIP1&2 Differential@5105

D1

D2

5105) Monitor

0.00 V

5108) Offset

100.00 %

5106) Range

10V

5109) Scaler

1.000 

5107) Output

100.0 %

smarty + option 03
UIP1 Analog@5110

D1

5110) Monitor

0.00 V

5113) Offset

100.00 %

5111) Range

±200V

5114) Scaler

1.000 

5112) Output

100.0 %

UIP Logic Block Digital ThesholdsUIP Logic Block Digital ThesholdsUIP Logic Block Digital Thesholds
Range Turn-On Turn-Off

5V 0.83V 2.5V

12V 2V 6V

24V 4V 12V



smarty Option 07 and 08, Encoder Inputs
Encoder inputs are EIA422/EIA485 receivers, 24V,  300KHz max. freq.

Two function block types provide bidirectional speed and logic information.

Notice that EIA422/485 signals  should be complementing differential-type. 
The “+” line must swing negative with respect to the “-” line for proper 
operation.  A single ended 0 to 24V logic signal may NOT register correctly.

Option 08 requires option 07.  

Speed block includes  a status  parameter that indicates  fault conditions on A 
and/or B.  Use this parameter to verify your EIA422 signals and connections.

smarty Option 11 Encoder Control F. B. Library 4
Option 11 requires option 07 and 08 and provides Position, Speed-lock and Registration function blocks. 

Encoder Position Function Block
Set up this block for absolute position measurement: 
1. Choose mechanical positions for 0 and 100%.
2. Enter number of  encoder revolutions required to move from 0 to 100%
3. You may dynamically update your 0% position with a zero-position 

signal input connected to the, “Reset,” parameter.

Encoder Speed Lock Function Block
Use this block to provide a numerical speed error signal. 
Check savvy User Manual, Appendix A for detailed information on the 

following system implementations:
Create a Master Speed Follower, Speed Lock system:

Condition the error signal through a PI function block or similar 
and output a speed reference to a follower drive.

Create a Phase Lock system:
Condition the error signal through an Integrator and then 
through a PI function block or similar and output to drive.

Encoder Registration Function Block
Use this block to measure time or pulse delay between markers. 

Choose whether the registration markers  are signals  on Digital I/O 
inputs 1 and 2, Encoder markers Z or combinations of  DIO’s and Z’s.
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Encoder Terminals:
Enc.1 Opt. 07 	 Enc.2 Opt. 08  Description

B1 	 	 A1	 	    Encoder A+
B2 	 	 A2	 	    Encoder A-
B3	 	 A3	  	    Encoder B+
B4 	 	 A4	 	    Encoder B-
B5	 	 A5	 	    Encoder Marker Z+
B6 	 	 A6	 	    Encoder Marker Z-
B7	 	 A7	 	    +24VDC encoder power supply, 200mA max.
B8 	 	 A8	 	    0V

smarty w/ encoder
ENC1 Logic@5111

max voltage: ±25V

common-mode:
-10V to +13.2V

threshold:
0V ± 200mV

hysteresis: ! 45mV

B1

B2

B3

B4

B5

B6

5111) Output A

High

5112) Output B

High

5113) Output Z

High

smarty w/2 encoders+11

ENC Speed Lock@5109

A

B

B1

B2

B3

B4

A

B

A1

A2

A3

A4

5111) ENC1 Ratio

1 

5109) ENC1 Status

OK

5112) ENC2 Ratio

1 

5110) ENC2 Status

Fault on A and B

5113) Scaler

1 

5114) Error

0 

smarty w/2 encoders+11

Registration@5102

! 8V

hysteresis ! 4V

C5

DIO1

! 8V

hysteresis ! 4V

C6

DIO2

5103) Master Edge

Rising Edge

5105) Measurement

Time ("s)

5102) Configuration

DIO1 & DIO2

5104) Slave Edge

Rising Edge

5106) Scaler

1 

5107) Output

0 

smarty w/ encoder
ENC1 Speed@5106

A

B

B1

B2

B3

B4

5106) Status

OK

5107) Pulses Per Revolution

1024 ppr

5108) Speed

0 RPM

5109) Base Speed

1800 RPM

5110) Output

0.00 %

smarty w/2 encoders+11

ENC1 Position@5115

A

B

B1

B2

B3

B4

5116) Pulses Per Revolution

60 ppr

5118) Base Revs

10 revs

5117) Reset

Inactive

5119) Output

0.04 %

5115) Status

OK



smarty Appendix A Function Blocks by Library and Option
Bold header indicates function block category.  Precursor number is # of  parameters inside each block.

Appendix B drive.web Product Line Overview
smarty Full featured controller simultaneously manages many varied process components and drives.

speedy sp and speedy485 Processing power, tailored for your drive or generic, Ethernet, EIA485 

savvy Signal Flow Diagram Option Easily implement your systems  designs.  “Drag n’ Drop,” 
connections with complete, graphical documentation created in one step and stored in your device. 

drive.web Training Courses-an essential component in your drive.web system.  On-line and factory 
courses are available at all technical levels. Sign up to get the most out of  your drive.web technologies.
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Arithmetic
  3 Adder
  3 Divider
  3 Multiplier
  3 Subtracter
Clamps
  4 Clamp

Control
 15 PI
Drive Helper
 11 Optidrive Helper
Logic Gates
  3 AND
  2 NOT

  3 OR
Switches
  4 2-In Switch
  4 2-Out Switch
Utility
  1 Dev. Comms Monitor
  1 Indicator

  4 Parameter Block
  6 Watchdog
  1 Watchdog Driver

Basic smarty

Arithmetic
  3 Differential Splitter
  4 Multiplier-Divider
  3 Sign And Value
  3 Sign Changer
Clamps
  5 Clamp with Monitor
  4 Deadband
  4 Skipband
Comparators
  4 Comparator
  5 Equality Comparator
  3 Maximum
  3 Minimum
  6 Window Comparator
Control
  6 Differentiator
  8 Integrator

 15 PI
 20 PID
  8 Profiler
Counters
 17 Up/Down Counter
Drive Helper
 11 Optidrive Helper
Filters
  4 Low Pass Filter
  5 Moving Average Filter
 Latches
  4 D Latch
  5 D Latch with Reset
  5 D Latch with Set
  6 D Latch w/Set, Reset
  3 SR Latch
  4 T Latch

Logic
 17 16-Bit Binary Encod.
 17 16-Bit Binarty Decod.
  5 4-Bit Binary Encoder
 16 4-Bit Priority Encod.
  3 Bitwise AND
  2 Bitwise NOT
  3 Bitwise OR
  3 Bitwise Shift
  3 Bitwise XOR
Logic Gates
  3 NAND
  3 NOR
  3 XNOR
  3 XOR
Ramps
  7 Linear Ramp
 11 MOP

 17 S Ramp
Switches
 18 16-In Switch
 18 16-Out Switch
  6 4-In Switch
  6 4-Out Switch
 10 8-In Switch
 10 8-Out Switch
  3 Track and Hold
Timers
  5 Delay-Off  Timer
  5 Delay-On Timer
  3 One Shot
  5 Oscillator
  8 Underlap
Utility
  4 User Logger

Process Control Library Option 05

I/O
  2 AOP’s
  3 DIO’s
  5 UIP Differential
  5 UIP Analog
  3 UIP Logic

Option 03

I/O
  3 ENC Logic
  5 ENC Speed

Options 07,08

I/O
 5 ENC Position
 6 ENC Speed Lock
 7 Registration

Option 11
Winder
 18 Diameter Calculator
  7 Taper Tension
 30 Torque Compensator

Option 06
Utility 
  4 Modbus Indirect 

Option 02, 04

ModbusRTU Master
  7 Comms Port
 48EurothermERCFW09
  6 Holding Reg. INT16
  6 Holding Reg. UINT16
 54 Optidrive Plus
 54 Optidrive VTC
 48 WEG CFW09

Option 12

Math
  2 ArcCosine
  2 ArcSine
  2 ArcTangent
  2 Cosine
  2 Cube
  2 Cube Root
  2 Exponential
  2 Logarithm
  2 Reciprocal
  2 Sine
  2 Square
  2 Square Root
  2 Tangent

Option 10

drive.web 40 Log Canoe Circle, Stevensville, MD 21666 USA. 
Ph. 410-604-3400, Fax 410-604-3500, www.driveweb.com
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